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Basic Tone and Color

As you start working on the actual adjustments
to optimize your images, basic tonal and color
adjustments provide the foundation for building
the final result. Having a firm understanding of
how to apply these basic adjustments will ensure
you are working toward the best quality from the
beginning. For many images, these may be the
only adjustments you need. For other images,
these adjustments represent the first step toward
producing an image that matches the vision you

had when you first clicked the shutter release.

Chapter Contents
Interface Tools for Evaluation
Prioritizing Adjustments
Tonal Adjustments

Color Adjustments
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Interface Tools for Evaluation

In Chapter 2, “Download and Sort,” I presented the navigation tools and explained
how they could be used to evaluate your images for sharpness and other image-quality
considerations. As you get started with the basic tonal and color adjustments for pho-
tographic images, it is helpful to know about some other methods for evaluating your
images so you can make better decisions about the specific adjustments to make and
image-quality issues to keep an eye out for (Figure 5.1).

Figure 5.1 Carefully evaluating your image provides the opportunity to ensure that your adjustments
result in the image you envisioned, even when tricky lighting conditions create a challenge to achieving
the desired result. (Photo by Gabby Salazar)
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Evaluate Channels

An image in the RGB color space is defined not by color information directly, but
rather by three individual grayscale channels—one each for red, green, and blue. Each
of these defines the brightness value for their particular color for each pixel, and the
three values combined determine the actual color of each pixel.

You may be tempted to ignore the underlying channel information, focusing
your attention instead on the full-color version of the image as you evaluate it. How-
ever, looking at the individual channels can help you gain a better understanding of the

overall quality of an image.

Note: Photoshop Elements doesn't include a Channels palette, so this method of evaluating can be \!l/

used only in Photoshop. @

Each channel contains a grayscale image—a black-and-white version of one of
the three color components in your image. To view the channels, you’ll first need to
make sure the Channels palette is visible (Figure 5.2); if it isn’t, choose Window >
Channels.

Figure 5.2
ki The Channels palette allows you to evaluate
the individual color channels that make up

your image.

To view an individual channel, simply click its thumbnail in the Channels
palette. The document display will then be updated so you see only the grayscale infor-
mation contained in that particular channel (assuming Color Channels in Color is no#
selected in Preferences > Display & Cursors), rather than the full-color version of the
image (Figure 5.3).

You can use this grayscale view to evaluate the image for lost detail (much easier
to do than when the channels display in color) or for quality problems on a particular
channel. Each channel is used to define what color information is available within the
image, so for example if there is a loss of detail in the blue channel, you can expect that
blue or yellow (the opposite of blue) areas of the image may not have sufficient detail.

This is also a great opportunity to look for noise or other problems that can
affect overall image quality. The blue channel is where you’ll tend to find the most noise,
so taking a close look at it can give you a much better sense of how much overall noise
exists within the image. When you are finished evaluating each color channel, click the
RGB thumbnail to return to the full-color view of your image.
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Red channel

Green channel Blue channel

Figure 5.3 Besides looking at the overall color image, reviewing the individual color channels can give you a better idea of
image quality.

Evaluating the individual color channels for your image gives you a much better
feel for how much detail you’ve retained, how much color information exists for each
color channel, and other issues affecting overall quality. If you have any concerns about
the detail or quality of a particular image, a quick review of the individual channels can
address those concerns.

Note: Forthose who like keyboard shortcuts, you can also view the individual channels by holding the
(trl/Command key and pressing 1 for red, 2 for green, or 3 for blue.To return to the full-color version of the
image, press Ctrl/Command plus the tilde key (~).The title bar will indicate which channel you are currently
viewing.

Display Full Saturation

If you ever have a difficult time evaluating the overall color in your images, temporarily
boosting the saturation to its maximum value can provide a dramatic indication of
exactly what colors exist in various areas. Besides exaggerating the colors that obvi-
ously exist within the image, this technique often reveals colors you weren’t expecting
to see. In particular, it can be a great tool for discovering subtle color casts in areas you
thought were neutral.
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To apply this adjustment, choose Image > Adjustments > Hue/Saturation from
the menu (Photoshop) or Enhance > Adjust Color > Adjust Hue/Saturation (Photoshop
Elements). This will bring up the Hue/Saturation dialog box (Figure 5.4), which will be
addressed in great detail later in this chapter and in Chapter 8, “Advanced Color
Adjustments.” Move the Saturation slider all the way to the right, producing a value of
+100. This will boost all colors in the image to their maximum saturation. Leave this
dialog box open as you evaluate the image, moving it aside if needed by clicking and
dragging on the dialog’s title bar.

st N
= d e || I

= o (| Figure 5.4

- w0 [ 1|  The Hue/Saturation dialog box allows you to
7| (= ) . .

L 7 adjust the saturation of all the hues in your

- T image or of individual hues. To saturate the
* L i hues to their maximum potential, move the
Saturation slider all the way to the right.

Review the full-saturation display of your image to get a sense of the colors in
various areas (Figure 5.5). Pay particular attention to colors you feel don’t belong
where they are showing up. Don’t worry that the colors temporarily look much worse.
Instead, use this as an evaluative tool for making decisions about what color correc-
tions might be necessary later, and what color issues to keep in mind as you work to
optimize your images. When you’re finished evaluating the image, click Cancel to close
the Hue/Saturation dialog box without applying an adjustment to your image.

Figure 5.5 By temporarily increasing saturation to the maximum value, you can get a better idea of what color influences can be

found in your image.
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Prioritizing Adjustments

In any image-optimization workflow, it makes sense to perform the most basic adjust-
ments first and then move on to more advanced adjustments that allow you to exercise
better control over your images. Taking this approach tends to simplify the process and
allows you to gradually build to more advanced adjustments as needed.

Some images may require only minor adjustment, and in those cases only the
basic tools need to be employed. For other images you may need to pull every trick
out of your bag to get the result you are looking for. That doesn’t mean you should
be focusing on fixing problem images. In fact, I typically recommend working on
only your very best images. The advanced methods, which will be discussed later in
this book, are still applicable to those images, allowing you to realize your true
vision for them.

Starting the image-optimization workflow with the most basic adjustments also
makes sense because that fits well with the typical process of learning to optimize your
images. It is normal to start with the basics as you gradually start your trek up the
learning curve. With a firm grasp on the basic adjustments you’ll want to apply, you
can produce pleasing results for the vast majority of your images. As you progress to
more advanced techniques, your results will only improve, and you’ll be able to better
achieve your goals.

In this section and the following ones, Il be talking about the basic tonal and
color adjustments. I often refer to these as the mini-lab adjustments, because they rep-
resent about the degree of adjustment you could expect from a good film-processing
lab. If the image was captured with proper exposure in the camera, these adjustments
may be all you need. More likely, however, you’ll want to move beyond these basic
adjustments to produce even better results, as I’ll discuss in later chapters.

The adjustments are presented here in what I consider to be the most logical
order. However, that doesn’t mean that this order is right for every image. My general
philosophy for performing adjustments is to solve the biggest problem first and then
move on from there—in other words, prioritizing the adjustments based on the signifi-
cance of each adjustment to the final result.

For most images, the tonal adjustment tends to be the most significant. Most
digital cameras do an excellent job of capturing accurate color, and saturation tends to
be good. Therefore, the standard order for me is tonal adjustment, color balance
adjustment, and saturation adjustment.

Note: Youshould feel comfortable changing the order in which you apply adjustments to your images
if the situation warrants it. Focus on solving the most significant problem with your image first and then
working onward from there.

If you have an image for which the exposure was very good but the color is a bit
off, you should feel perfectly comfortable making your color balance adjustment first
before moving on to the tonal adjustments. Although the basic workflow presented in
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this chapter will work best for the majority of images, you should think of each adjust-
ment as a modular piece of the full workflow. When the situation warrants, you
shouldn’t hesitate to change the order in which you perform the specific adjustments
for your images.

Tonal Adjustments

The broad category of tonal adjustments includes any change in overall brightness or
contrast within an image. Even more broadly, this category includes any adjustment
that changes the luminosity values of an image, without emphasis on changes to the
colors within an image. Tonal adjustments can most certainly affect colors—for
example, darkening an image tends to saturate the colors, and brightening makes the
colors appear less saturated. However, when making tonal adjustments your focus is
on the brightness and contrast, not the color.

Although there are a virtually unlimited number of methods you could use to
perform tonal adjustments, many of which will be covered later in this book, this sec-
tion focuses on the most basic tonal adjustments.

Brightness/Contrast

The most basic tonal adjustment available in Photoshop is the Brightness/Contrast
adjustment (Image > Adjustments > Brightness/Contrast). This dialog box contains only
two sliders—one for Brightness and one for Contrast (Figure 5.6).

Figure 5.6

The Brightness/Contrast dialog box provides two simple sliders
Coaun o i e that allow you to easily perform tonal adjustments, but doesn't
provide the control necessary to produce the very best results.

The Brightness/Contrast adjustment has a bit of a bad name among photogra-
phers. In many respects, the control provides the same general capabilities as other
tonal adjustment options. There is nothing wrong with a basic brightness slider that
allows you to adjust the tonality of your image, and this control is very similar to other
adjustments you’ll look at later.

However, the Contrast slider in the Brightness/Contrast dialog box can be a bit
of a problem. This is because it affects both the highlights and shadows within your
image to the same extent, brightening highlights to the same degree that it darkens
shadows. This may not seem like a significant problem, but when you consider the
importance of preserving highlight detail within your images, the limitations of this
adjustment tool become more clear.

One of the advantages of other tonal adjustment methods is that, unlike the
Brightness/Contrast adjustment, you are able to adjust black point (shadows) and white
point (highlights) independently. In other words, you can increase the overall perceived
contrast by sacrificing shadow detail, which isn’t generally a problem, without sacrific-
ing highlight detail. You can achieve the same degree of perceived contrast without pro-
ducing highlight areas that look “wrong” because too much detail has been lost.

Copyright © 2005 SYBEX Inc., 1151 Marina Village Parkway, Alameda, CA 94501. World rights reserved.
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Another side effect of using the Brightness/Contrast control is that it can be diffi-
cult to produce pleasing contrast. Often, the choice seems to be between not enough

contrast and an image that looks a bit harsh (Figure 5.7).

Figure 5.7

The Brightness/Contrast
adjustment makes it easy to
perform basic tonal adjust-
ments on an image that
looks flat (top). However,
there is a considerable risk of
producing images that have
a little too much contrast
(bottom) with too much
detail sacrificed in highlights
or shadows.

Having said all that, there are still times when you will want to use the Bright-
ness/Contrast dialog box. For one thing, it is a good way to get started when you aren’t
yet familiar with the other options available to you. Also, at times simplicity may be
important, either because you are trying to quickly prepare an image for sharing on the
Web or via e-mail, or because you are having a difficult time using the more advanced
controls on a given image. It is a convenient control to use when an image needs a
simple contrast boost (Figure 5.8).
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Figure 5.8

When an image requires a
simple boost in contrast,
the Brightness/Contrast
adjustment may provide
all the control you need to

improve the image.

As you’ll see throughout this book, I feel strongly that all adjustments should be
performed on a separate layer, rather than adjusting the pixel values in your image
directly. Adjustment layers are special layers that don’t contain pixel data, but instead
hold instructions on how the actual pixels in the image should be changed in appear-
ance. Therefore, the first step toward making a Brightness/Contrast adjustment (or any
other adjustment for which an adjustment layer is available) is to make an adjustment
layer. To do so, click the Create New Fill Or Adjustment Layer button at the bottom of
the Layers palette (top of the Layers palette in Photoshop Elements). This is the button
with a half-black and half-white circle icon on it. A list of available adjustment layers
will then be displayed (Figure 5.9).

Figure 5.9

s Click the Create New Fill
Erighiramssost it Or Adjustment Layer

Hel .. . button (the one with the
e half-black and half-

Prata fikar.. white circle icon) to see
———— a list of available adjust-
ment layer types.
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Note: Adjustment layers enable you to provide instructions on how an image should be modified with-
out changing pixel values directly. Using these layers is the preferred method for adjusting your images.

Select the Brightness/Contrast item from the list of available adjustment layers,
and the layer will be created. You’ll see on the Layers palette that the adjustment layer
is placed above the currently active layer. In this case, because you’re making the first
adjustment on this image, the only layer is the Background layer, so the adjustment
layer goes above that. In addition to the new adjustment layer in the Layers palette, the
Brightness/Contrast dialog box is displayed (Figure 5.10). You’re immediately ready to
start making adjustments to the image, comfortable that these adjustments are being
handled by an adjustment layer that effectively behaves as a filter over your image,
rather than causing changes to the underlying pixel values.

Figure 5.10

The Brightness/Contrast dialog box is displayed when
you create a new Brightness/Contrast adjustment layer,
allowing you to perform basic tonal adjustments on
your image.

The approach I recommend for using Brightness/Contrast is to start with the Con-
trast slider and then fine-tune with the Brightness slider (Figure 5.11). Because the Contrast
adjustment has the potential to cause a significant loss of information within the image,
establishing this value to optimize contrast without sacrificing significant detail is the most
important consideration. The Brightness slider then becomes something of a fine-tuning
control, allowing you to adjust the overall brightness without significant concern of causing
a greater loss of detail in highlights or shadows. Make sure the Preview checkbox is selected
so you can see the effect of every adjustment in your image as you move the sliders.

When you’re finished fine-tuning the Brightness and Contrast sliders, click OK
to apply the changes to this adjustment layer. You’re now ready to evaluate the results
of your adjustment (Figure 5.12). Although you were able to see the effects of your
adjustments as you made them, sometimes it is difficult to make a good evaluation of
the final result as you’re making minor adjustments to the sliders. I therefore recom-
mend after making an adjustment that you take an overall look at the image and evalu-
ate it with and without the adjustment you’ve applied.

The easiest way to do this is to turn off the visibility of the Brightness/Contrast
adjustment layer on the Layers palette. To do so, click the eye icon to the left of the
layer. In the case of an adjustment layer, what you’re hiding or revealing is the effect of
that layer. By toggling the visibility off and on, you can switch between “before” and
“after” views of the adjustment. This gives you a greater perspective on the adjustment
you’ve applied to the image, and this context often makes it much easier to make a crit-
ical evaluation of the results you’ve achieved. The hope, of course, is that you like the
after version more than the before.
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Figure 5.11

A good approach to using Brightness/Contrast
is to adjust the Contrast slider to achieve the
desired contrast within the image, and then
fine-tune using the Brightness slider.

Figure 5.12

Although other adjustment tools provide
greater control over the changes you make
to your images, Brightness/Contrast does
enable you to make good basic adjust-
ments provided loss of highlight detail
doesn’t become a problem.
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Note: Ifyouare working with a 16-bit image with adjustment layers in Phatoshop but need to convert
that image to 8-bit, flatten the image first so the adjustment layers will apply to the high-bit data. If you
convert to 8 bits per channel without flattening, the adjustment layers will have their adjustments scaled to
the 8-bit data, and you'll have lost the benefit of making adjustments in 16-bit. (Photoshop Elements
doesn’t support adjustment layers for 16-bit images.)

If at any time you decide you aren’t completely happy with the adjustment
you’ve made, whether for the Brightness/Contrast adjustment layer you’ve created or
any other adjustment layer you’ll make later, revising the adjustment is remarkably
easy. Simply double-click the thumbnail icon on the Layers palette for the adjustment
layer you’d like to revise, and the dialog box will be displayed. The sliders and any
other controls in the dialog box will be exactly where you left them the last time you
clicked OK. You can then change the settings for any of the controls, revising your
original adjustment. In fact, you can return to the adjustment layer as often as you like,
making an infinite number of revisions, without any concern of cumulative damage to
your image. That is because only the final settings count; earlier “versions” don’t dam-
age the image, because you are applying an adjustment without changing the underly-
ing pixel values in your image.

Benefits of Adjustment Layers

There are many benefits to using adjustment layers rather than adjusting pixel values directly
within your image. Among the most significant benefits are the following:

e There is no cumulative loss of image quality when making multiple adjustments because you
are effectively applying a filter over your image rather than changing the underlying pixel
values.

*  You can quickly see a“before” and “after” view of your image by turning off the visibility of
any adjustment layer.

*  You can revise the adjustment at any time by double-clicking the thumbnail icon for the
adjustment layer on the Layers palette, and all the controls will be exactly as you left them
last time you clicked OK in the dialog box for that adjustment layer.

*  You can reduce the Opacity of the adjustment layer as a quick way to reduce the effect with-
out changing the actual settings for the adjustment layer.

*  You can apply a layer mask to the adjustment layer to target the adjustment to specific areas,
as I'll cover in Chapter 10, “Targeted Adjustments.”

Levels

The Levels adjustment provides much greater control over tonal adjustments for your
images. In many respects, it can be thought of as providing the same overall functional-
ity as Brightness/Contrast, but Levels provides the capability to adjust contrast by inde-
pendently controlling shadows and highlights within your image.
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Of course, this makes Levels sound remarkably easy, which isn’t necessarily the
conclusion you would draw after looking at the Levels dialog box (Figure 5.13). After
you have a better understanding of the basic information presented in this dialog box
and of the methods you’ll want to utilize for basic tonal adjustments (and even color
adjustments by working on individual color channels), you’ll feel very comfortable
using Levels and will be less likely to decide to revert to Brightness/Contrast.

Figure 5.13

The Levels dialog box appears rather complicated, but
after you understand how to utilize this control effec-
tively you won't feel intimidated. The key controls allow
you to adjust the black point (B), middle-tone value
(M), and white point (W).

The primary component of the Levels dialog box is a histogram display that
charts the distribution of tonal values within your image. The tonal values are repre-
sented from black at the extreme left to white at the extreme right. This gradation of
tonal values is shown as a gradient bar along the bottom of the histogram chart. The
shape of the histogram chart tells you about the distribution of tonal values within the
image. For example, histogram data that is shifted toward the left (Figure 5.14) indicates
that the image is generally dark. However, that doesn’t necessarily tell you anything about
the quality of the image; it may simply be a dark scene. Similarly, a brighter image will
have a histogram shifted toward the right.
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Figure 5.14 A histogram chart that is shifted to the left indicates that the image is relatively dark—but doesn’t
provide any real information about the quality of the image.

Problem Signs

The key things to watch out for on the histogram are clipping and gapping. Clipping is
an indication that information has been lost in the highlights or shadows of your image.
Gapping is represented by gaps in the histogram, and indicates tonal values that are not
represented in your image.
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Clipping is indicated on the histogram display by data running off the end of the
chart. There are two ways clipping might be displayed. One is as a spike at one end of
the chart. This is most commonly seen at the highlight end and is often caused by spec-
ular highlights within your image, such as reflections from water, glass, or metal. In
other words, it isn’t necessarily a major problem within the image, as we don’t expect
to see detail in such highlights.

The other type of clipping is more likely to represent a problem within your
image, especially if it occurs in the highlights. In this type, the data of the histogram gets
cut off abruptly at the end of the chart, rather than ending gracefully before the chart
ends (Figure 5.15). If you think of the histogram as representing a mountain range, ide-
ally the mountains should gradually drop down to the flatland before the chart ends. If
instead the mountains end suddenly in a cliff, detail is lost in the area that would have
gradually lowered to the base of the chart. All pixels within the “missing” tonal values
have been clipped to the minimum (black) or maximum (white) value at that end of the
histogram chart.

&
' Figure 5.15
~ Clipping exhibited by an abrupt cutoff of
- - - I tonal data at the highlight (right) end of the
- %  histogram chart indicates a potentially seri-
i ous loss of detail in your image.

Ideally, your image shouldn’t exhibit any clipping when you get started with
your adjustments. If it does, it is generally preferred that the clipping occur in the shad-
ows rather than the highlights, as we are usually more forgiving of lost shadow detail
in a photographic image than blown highlights. However, you also want to be careful
not to produce excessive clipping as you are adjusting contrast with Levels.

Another problem to be aware of is gapping in the histogram (Figure 5.16). You
can think of the histogram chart as a bar chart made up of many narrow bars, so that
the final result typically looks like a curving data display rather than one composed of
individual bars. However, when gapping occurs, you start to see the individual bars
that create the data display. Gapping indicates that certain tonal values are not repre-
sented by any pixels (or by very few pixels) in the image.

: I;..., e (8 | Lom [ '_ Gapping in the histogram indicates that all
r available tonal values are not represented in
== the image. When gapping becomes significant

."-Illl | - | M enough, the result is a loss of smooth grada-

—'__ i tions of tone and color in the image, referred

i to as posterization.
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Note: Gapsin the histogram rarely occur for 16-bit files, because many more values are available than
the 256 represented by the histogram display. 16-bit files have 65,536 tonal values per color channel avail-
able, compared to 256 values per channel for an 8-bit file. As a result, 16-bit files can lose a significant num-
ber of tonal values without obvious gapping or the posterization it can be indicative of.

Gaps in the tonal values indicate that smooth and subtle transitions between
tones and colors within the image may be compromised. Instead of making a gradual
change from one value to another with 10 values in between, for example, the transi-
tion may be from one value to another without any transition values between them.
This lack of smooth gradations is referred to as posterization.

However, gaps in a histogram are not an immediate indication of a serious prob-
lem with your image. Minor gaps of only a few pixels wide, representing just a few
tonal values, aren’t likely to be visible with the human eye. In fact, it isn’t until the gaps
become relatively extreme (at least 10 tonal values) that they are likely to be visible in
the final output. Although gaps certainly indicate a potential problem, they don’t define
image quality by themselves. If you have significant gapping in an image, use caution
not to make extreme adjustments that may worsen the situation, and closely evaluate
the final image to ensure there isn’t visible posterization.

Basic Levels Adjustments

With a basic understanding of the concepts behind Levels, you’re ready to start making
an adjustment. To do so, create a new adjustment layer for Levels by clicking the Cre-
ate New Fill Or Adjustment Layer button on the Layers palette. For most adjustments
with Levels, there are only three controls you need to adjust. These are the black point,
white point, and middle-tone sliders. All three are found directly below the histogram
display in the Levels dialog box. The black point slider (for shadows) is at the far left,
the white point slider (for highlights) at the far right, and the midtones slider in
between the two. Together these controls allow you to adjust the overall contrast (with
the black point and white point sliders) and brightness (with the midtones slider) of
your image with excellent control.

As with the Brightness/Contrast control, I recommend establishing overall con-
trast before fine-tuning brightness. Therefore, I suggest starting with the black point
and white point sliders. These provide contrast adjustment with the ability to vary the
amount of adjustment being applied to the shadow and highlight areas of your image.
You can therefore, for example, sacrifice more detail in the shadows to improve overall
contrast without losing significant highlight detail.

As a general rule, most images benefit from having the brightest pixel value set
to white and the darkest pixel value set to black. There are obviously plenty of excep-
tions to this, but it is a good basic rule. Because we know that the last data point at
either end of the histogram chart represents the darkest and brightest pixels, a very
basic adjustment could be made by dragging the black point and white point sliders
inward to the point where the data begins at each end of the histogram (Figure 5.17).
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Fodiesk M | L | Figure 5.17
: A good general approach to setting the black
and white points within Levels is to bring the
- - : o black point and white point sliders inward to
by the point where the data begins at each end

of the histogram chart.

Of course, this is a somewhat arbitrary way to approach an image. Although it
will indeed produce good results for most images, it isn’t an ideal solution for every
one. Photography is very much a visual pursuit, so it makes sense to perform a visual
review of the image and decide whether you’re happy with the results of the adjustment
you’ve made. You may want to back off the adjustments slightly in some situations to
minimize the risk of introducing excessive contrast. In other situations you may want
to bring the sliders in just a bit farther to produce stronger contrast. It is up to you to
determine the best adjustment for a particular image.

Note: Ifyou're having trouble making appropriate adjustments, you can hold the Alt/Option key to
change the Cancel button to a Reset button in most dialog boxes in Photoshop. If you then click the Reset
button, all settings in the dialog box will return to their default values.

After you’ve established the black and white points for the image, effectively per-
forming a well-controlled contrast adjustment, you are ready to adjust the middle-tone
slider. This slider can be thought of as a brightness control. Moving the slider changes
which pixel value within the image should be mapped to a middle-gray tonal value, but
the result is a brightness shift. This adjustment doesn’t have any rule of thumb you can
follow in terms of positioning the slider at a particular point along the histogram chart,
so you’ll need to make a decision based on a visual review of the image.

When you’ve adjusted all three sliders, you’ve finished the basic tonal adjustment
with Levels. Click OK, and the Levels dialog box will close. As with any other adjust-
ment layer, if you change your mind about the adjustment at a later time, you can sim-
ply double-click the thumbnail icon for the Levels adjustment layer on the Layers palette
and the dialog box will be displayed, with the sliders positioned exactly as you left them
last time you clicked OK.

Note: The Levels dialog box also includes eyedroppers that allow you to click areas of your image to
automatically set the black, white, and neutral values. However, these tools tend to require a hunt-and-peck
approach that doesn't allow you to make very accurate adjustments, so | prefer not to use them.
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Clipping Preview

Although a basic visual evaluation of your image while making adjustments with Levels
is certainly effective, it can be even more helpful to use the clipping preview display
available in Levels. This display allows you to see exactly where you are losing detail
within your image as you adjust the black point and white point sliders. As a result,
you can make a much more informed decision about the settings you’d like to use for
these sliders.

When you start with an image that lacks strong contrast (Figure 5.18), and want
to maximize the contrast without sacrificing detail in highlights or shadows, the clip-
ping preview display allows you to see exactly where you’ll lose detail based on your
specific adjustment of the black point and white point sliders.
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Figure 5.18

If you have an image such as this one
that lacks adequate contrast, it is
helpful to be able to maximize con-
trast without sacrificing highlight or
shadow detail. The clipping preview
feature of Levels provides exactly this
solution.

I recommend adjusting the white point first, simply because highlight detail
tends to be the more critical adjustment. If you’ve already created a Levels adjustment
layer for the image you’re working on, double-click the thumbnail icon for that layer
on the Layers palette. Otherwise, create a new Levels adjustment layer.
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To enable the clipping preview display, hold the Alt/Option key while you adjust
the white point. Your image display will initially change to a completely (or almost
completely) black display. This indicates that no pixel values (or very few) are clipped
to white without making any adjustment. As you continue to hold the Alt/Option key,
slide the white point slider to the left. You’ll see more pixels showing up as you move
the slider (Figure 5.19). As a general rule, I recommend adjusting the white point until
pixels just start showing up in the clipping preview. This is the point where you’ve
maximized contrast and tonal range within the image, while sacrificing minimal high-
light detail. Of course, the benefit of the clipping preview display is that you’re able to
make an informed decision about the amount of detail you are sacrificing to achieve
the level of contrast you’d like to see, and that detail’s location within the image to

achieve the level of contrast you’d like to see in the image.

Figure 5.19 By holding down the Alt/Option key while adjusting the white point slider in Levels, you'll see a clipping preview
showing you where in the image you'll lose highlight detail for a given adjustment.

Note: The color of the pixels that show up in the clipping preview display indicate the color channels
that are losing detail within the image. The pixels won't appear as pure white or black in the image until the
clipping preview shows those values. However, even if they aren’t pure white or black, they are probably
very close if any channels are clipping, so you can generally treat such values as though they were indeed
white or black.
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The process for setting the black point is nearly identical: hold the Alt/Option key
while adjusting the black point slider, and you’ll see a similar clipping preview display,
except that now it will start completely (or almost completely) white, with pixels show-
ing up to indicate where you’re losing shadow detail (Figure 5.20). As discussed previ-
ously, you are generally willing to sacrifice more shadow detail as opposed to highlight
detail to maximize contrast. The clipping preview allows you to make an informed deci-
sion about how much detail you’re giving up with a particular adjustment and the loca-
tion of that detail, so you can better determine the extent to which you can push the
black point to produce the desired contrast level.
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Figure 5.20 While holding down the Alt/Option key and adjusting the black point slider in Levels, the clipping preview shows
where the image will lose shadow detail for a given adjustment.

After you’ve adjusted the black and white points by using the clipping preview,
you’re ready to adjust the middle-tone slider for overall brightness. Because this doesn’t
affect the extreme tonal values within the image, there isn’t a clipping preview for the
middle-tone slider. You’ll need to rely on a visual evaluation of the image for this
adjustment.

When you’re finished with all three of these adjustments, using the clipping
preview for the black and white points, you’ve produced an image with optimal con-
trast based on your willingness to sacrifice detail to achieve your goals for the image
(Figure 5.21).

Copyright © 2005 SYBEX Inc., 1151 Marina Village Parkway, Alameda, CA 94501. World rights reserved.

Y

SLNAWLSN[AVY TYNOL ® ©

~N



iy
(=]
[

CHAPTER 5: BASIC TONE AND COLOR =

Figure 5.21

After you have adjusted the
black and white points by using
the clipping preview of Levels,
and then fine-tuned the mid-
dle-tone slider to taste, the
result is an image with optimal
contrast and with detail lost
only where you've decided it
was worth sacrificing.

Color Adjustments

After you’ve optimized the overall tonality of your image, the next step is typically
color adjustments. At the most basic level, these include adjusting the color balance to
remove any undesired color cast or to introduce one that is desired, and adjusting the
saturation of colors within the image to taste.

Color Balance

Color balance adjustments are most often thought of as ways to eliminate an undesir-
able color cast within an image. In many cases the goal is to make areas that should be
neutral in the image truly neutral. However, this can be a challenging goal to achieve.
Just because something truly is neutral doesn’t mean it should appear as perfectly neu-
tral within your image. For example, if you place an 18% gray card in a scene during
sunrise, you can be assured that the gray card won’t appear gray. It will be influenced
by the warm light of sunrise and will appear with a golden hue.

Note: Photoshop Elements does not include a Color Balance adjustment. However, it does include other
color adjustment options that will be covered in later chapters.You can also use the Color Variations com-
mand (Enhance > Adjust Color > Color Variations) to adjust color balance by clicking the thumbnail at the
bottom of the dialog box that represents the best color, selecting each best option in turn until you produce
the best final result.
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Instead, I feel the focus of a color balance adjustment should be to eliminate any
color influence you don’t like and to add a color influence you do like. The result needs
to be close to reality to be accepted by those who will view your images, but you do
have a fair amount of latitude. Focus on producing the best aesthetic results, and you’ll
be well on your way to accurate results as well.

The simplest way to make basic color balance adjustments is with the Color
Balance dialog box. This dialog box includes three sliders as the primary controls (Fig-
ure 5.22). These represent the color axes for each of the three channels that make up
your image. As an additional benefit, the sliders are labeled to remind you of the rela-
tionships between colors. Colors at opposite ends of a given slider are opposites of
each other, and moving the slider in one direction or the other will cause the overall
image to be shifted toward that color value.

[T —————
L xens 1 2 _ Figure 5.22
. The Color Balance dialog box provides sliders for
i - each of the three axes represented by the color
T spars channels that comprise an image, and allows you
—— to adjust the balance for color along each axis.

It is important to keep in mind that when you make a color balance adjustment
to your image, you are adjusting all pixel values within the image. Of course, in later
chapters youw’ll look at how to control the adjustments so they affect only certain areas
of the image. For now, the key to understand is that just because you are moving a
slider between cyan and red doesn’t mean you will affect only those pixels within the
image that are cyan or red. Rather, all pixels within the image will be shifted toward
the color value you choose with the slider.

As with other adjustments, the first step is to create a Color Balance adjustment
layer; doing so opens the Color Balance dialog box. I strongly recommend starting with
the axis that needs the most significant adjustment. For example, if you have an image
with a magenta cast (Figure 5.23), start with the Magenta/Green slider.

When adjusting a given slider, especially if you are not yet comfortable with
visualizing the particular adjustment required, I recommend moving the slider through
the extremes of its range. Besides helping you get a better sense of where an appropri-
ate color balance exists for a particular slider, this process will also help you develop
your skills for understanding how a particular adjustment will affect various color and
tonal values within your images. As you move the slider back and forth, starting with
the extremes, gradually zero in on the range that seems to provide the most appropriate
balance for that channel.

With the slider positioned as accurately as possible with the mouse, you can
then take advantage of keyboard shortcuts to fine-tune the adjustment. After you have
moved a slider, the text box that holds the final value for that slider will be active.
You can then use the up and down arrow keys on your keyboard to adjust the value
one unit at a time.
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Figure 5.23

If you have an image with
a slight magenta cast, the
Magenta/Green slider in
the Color Balance dialog
box should be the first
you adjust.

In the case of the sample image with a magenta color cast, your first step would
be to shift the color balance toward green by using the Magenta/Green slider (Fig-
ure 5.24). This will effectively neutralize the unwanted magenta color cast, producing
an image that is relatively neutral with accurate color.

However, just because you have achieved a neutral image with accurate color
doesn’t mean you are finished with the Color Balance adjustment. In fact, even if you
think the image has been adequately corrected with a single slider adjustment, adjust
the other two sliders to see if you can’t produce a better result. Often you’ll find that
by shifting the other sliders, you’ll produce an image with a more pleasing color bal-
ance than the neutral result you first achieved.

Note: Ingeneral, viewers respond more favorably to images with a warm color balance, so you may
want to explore a shift toward warmer values (red, magenta, yellow).

Looking again at our sample image, after producing a neutral result you might
want to explore adding a shift toward warmer values. In this case, I applied a shift
toward yellow to warm up the image and enhance the natural earth tones that were
already present (Figure 5.25). The result is an image with much greater warmth than
the original adjustment produced.
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Figure 5.24 A magenta color cast can be corrected by moving the Magenta/Green slider toward Green in the Color Balance
dialog box. After you have corrected the color cast in your image, the result is a relatively neutral image with accurate color.

Figure 5.25 After you've made adjustments to produce a neutral result, you can often produce a better final image by making
further adjustments. In particular, adjustments that warm up the image slightly are often appealing.
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After you’ve adjusted all three sliders in the Color Balance dialog box, the basic
process is complete. But keep going: move all three sliders again, this time making
much smaller adjustments. Because each slider move affects all of the colors within the
image, subsequent adjustments at least slightly alter the image; you might discover an
even better result.

For the vast majority of images, all you need to do is adjust the sliders in the Color
Balance dialog box after selecting the default Midtones setting in the Tone Balance section
at the bottom of the dialog box. However, you can also change the range of tonal values
within the image that will be affected by the Color Balance adjustment by selecting Shad-
ows or Highlights and making separate adjustments targeted at those tonal ranges.

Each of these options for limiting the tonal values to be affected by the adjust-
ment operates independently. When you select Shadows, for example, the adjustments
you make will not replace or undo adjustments you made when the Midtones option
was selected. The Midtones option will affect most values within the image, whereas
Shadows and Highlights will limit the adjustment to the darkest and brightest values
within the image, respectively.

Another option in the Color Balance dialog box is the Preserve Luminosity check-
box. With this option selected, when you adjust one slider the color values for the other
channels within the image will be modified slightly so that the perceived luminosity of
all colors is preserved. I recommend keeping this checkbox selected. The only time I rec-
ommend deselecting this option is when you are attempting to produce a perfect neutral
value and want to be able to control each channel’s color value independently.

Basic Saturation

After you’ve achieved appropriate overall tone and an accurate color balance, the next
consideration is the saturation of the colors within your image. This calls for a Hue/Satu-
ration adjustment (Figure 5.26). Although this control allows you to perform a wide vari-
ety of adjustments, for now I’'m going to focus on a basic saturation adjustment (though
not as strong an adjustment as I described at the beginning of this chapter when using
Hue/Saturation for evaluating the image). In Chapter 8 I'll cover Hue/Saturation in even
greater detail, but for now Ill keep it simple.

Start by creating a Hue/Saturation adjustment layer, in the same manner that
you created the other adjustment layers covered earlier.

i LA e me

Figure 5.26
. Hue/Saturation allows you to perform basic
saturation adjustments, along with a variety
of other adjustments covered in Chapter 8.

In general, photographers want to boost the saturation of the colors in their
images, so the most common adjustment is to increase the Saturation value. However,
there are certainly plenty of situations where you might want to reduce saturation
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slightly. For example, if you are producing an image with a watercolor appearance,
you’ll want to tone down the colors slightly so they don’t appear overpowering.

Note: Althoughitis possible to move the Saturation slider all the way to the left to produce a black- S0
and-white version of an image, this isn't the optimal method. In Chapter 11,“Creative Adjustments,”['ll @
cover a method for producing better black-and-white conversions.

Although reducing saturation can be done to any degree based on your prefer-
ence for how the image should look, a little more care should be taken when increasing
saturation. If you increase the saturation too much, you can create some problems
within the image. For one thing, the colors may start to look fake because they are too
vibrant. Also, by shifting colors to their most saturated values, you are reducing the
total number of possible values, and therefore increasing the risk of posterization in the
highly saturated areas of the image. As a general rule, use caution when increasing the
Saturation slider to a value above +20. That doesn’t mean you can’t increase Saturation
further, just that you should carefully review the image to make sure you aren’t intro-
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ducing any problems in doing so.

Other than exercising some care in how much you increase saturation, making an
adjustment is really as simple as deciding how strong you want the effect to be. If your
image doesn’t have very strong saturation (Figure 5.27), you can easily produce a more
pleasing image by increasing the Saturation slightly with a Hue/Saturation adjustment.

Figure 5.27 (left) When an image has colors lacking in vibrancy, the perception is an image that is flat. (right) Boosting the Satu-
ration adds life to the image.

Provided you are cautious not to apply an excessive boost in saturation, a basic
increase in Saturation with the Hue/Saturation adjustment is one of the more straight-
forward adjustments you’ll make in a basic workflow for your images.

Basically Done

After stepping through the adjustments covered in this chapter, you’ve completed the
basic image-optimization workflow. For some images, this will provide all the adjustment
you need, particularly if you started with an excellent capture right out of the camera.
After completing this basic workflow, you’re ready to move on to more advanced adjust-
ment options that allow you to exercise maximum control over your photographs.
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